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I. Principles

CONCEPT

Photosounder is based on the simple concept that a sound’s spectrum over time can be interpreted as an 
image, and that this can be reversed, an image can be interpreted as a sound spectrum over time. 
Photosounder is all about bridging the two domains, so that one may simply process a sound as if it was  
an image in order to create a transformed sound, or create a new sound from an image, an image that  
functions as a graphical desciption of the sound it creates.

When a sound is loaded, an image called a spectrogram is created. That spectrogram describes pretty 
extensively what composes that sound. Time goes from left to right, and frequencies from bottom for 
basses to the top for trebles. The brightness of the pixel define the volume at a specific place in time and 
frequency, the brighter the louder, the higher in position the higher in frequency, the more to the right  
the later it occurs in the sound.

The same principle is applied when turning an image into sound, so that if a sound is turned into an  
image, then that image is turned back into a sound, the sound will be somewhat similar.

SYNTHESIS MODES

In lossless mode the sound will actually be exactly similar. The other mode, noise synthesis, gives you 
a  somewhat  different  sound  from the  original.  Let’s  start  with  noise  synthesis.  When  an  image  is  
synthesised with this method, the image is divided into its constituant rows of pixels. Each horizontal line  
describes how the volume evolves through time, from left to right, depending on the brightness of the  
pixels, for a narrow band of noise centred around a frequency determines by the height of the row in the  
image. So for instance with an image that is 571 pixels high, the first row of pixels from the bottom 
describes the volume over time of a band of noise around 27.5 Hz (or A0), whereas the 241 st row of 
pixels from the bottom will  be centred around 440 Hz (A4). So an image simply containing a black 
background and a bright line going from the bottom left corner to the opposite top right corner will  
produce a tone that is steadily rising over time, this does so by multiplying each row of pixel with its  
respective narrow band of noise, then adding it all together into a sound. A white image would make  
each band of noise retain a constant volume, and all added together it would create a pink noise, which 
is a noise in which every octave has the same volume.

The lossless mode follows the same principle except for one major difference. Instead of cutting a pink 
noise into thin slices as a basis for the new sound, it cuts the original sound into slices in frequency, and  
then modifies each of such slices by comparing the new modified picture with the original. So imagine 
that  we  take  the  original  sound’s  image  and  simply  turn  one  pixel  black,  let’s  say  the  one  pixel  
representing the sound at 2 seconds from the beginning and 660 Hz. What the lossless mode would do is 
that it would dip the volume at 2 seconds for the frequency slice of the original sound at 660 Hz, then 
add it back with the other unchanged slices. The resulting sound would be identical to the original except 
at that point in time and frequency where it would be silenced, without affecting the rest of the sound.

Because the lossless mode is about changing the volume of the original sound to transform it, not all 
features are available. Time cannot be stretched because one couldn’t possibly stretch a sound properly 
by amplifying or silencing some parts, pitch cannot be shifted also for the same reason, and there must 
be no displacement of any part of the image. Typically all you should attempt to do with the lossless 
mode is to make some parts of the image darker or brighter, you can use this to equalise a sound, 
change its dynamics (like a compressor), silence or isolate some features like instruments or parasitic 
noises, or do something equivalent to vocoding. For everything else that breaks the relationship between 
the original sound and its image and the new modified image you should use the lossless mode.

There is also Live Synthesis, which you can enable in the Options menu, and I strongly recommend that 



you use it for noise synthesis. It’s just like noise synthesis but instead of being progressively rendered into  
a sound by blocks it is instead synthesised as the image is played back. This also gives you the freedom 
to control directly the playback cursor using the mouse cursor on the image, dragging it with the mouse, 
or  the  freedom to  change the  rate  of  playback  without  any interuption.  It  also  directly  reflects  the 
changes in the image into sound, you will hear the latest changes to the image as the playback cursor 
goes over that part of the image. This is extremely useful when editing a loop as you can hear the  
changes as you make them. The live synthesis also has the advantage that it loops seamlessly whereas  
the  non-live mode might  not.  So live  synthesis  is  superior  in  everyway,  except  for  how bad it  is  at 
normalising the volume of the sound, but typically this is only a problem for about the first second of  
playing a sound, then there’s no problem for the rest of the session.

PRINCIPLES OF OPERATION

Whether you load an image or a sound, Photosounder presents an image occupying the central area of  
the interface. Since that image is to be necessarily interpreted as a sound, the scales on the left, right  
and bottom show you respectively the frequency in Hertz,  the pitch  by  note name and the time in 
seconds.   Since  any image you might load is  to be turned into  a sound,  then the 1:1 relationship 
between its  horizontal  and vertical  axes doesn’t  need to be respected anymore as there is  no such 
relationship between time and pitch, so images do not keep their original aspect ratio and instead are  
stretched to fit the image area. An image isn’t an image anymore the moment you load it, it becomes a  
spectrogram, the graphical description of a sound to create.

II. Getting started

INSTALLATION

The demo version of Photosounder is simply installed by downloading it on the Photosounder website,  
and extracting the ZIP file to the desired location.

The full version is obtained by buying on the website. Once the payment has been received, you should 
almost instantly receive by e-mail a link to download the program as well as the license file needed by  
the full version of the program to run. If you haven’t, check inside your spam folder. The full version is  
installed by extracting the ZIP file and placing the license file in the same directory as the program. If it  
still says “Demo” that means you downloaded the demo. The demo cannot be activated and the full 
version has no demo mode, they’re two different programs. This is a common source of confusion. The  
full program comes from the URL that contains your serial number, it’s a permanent link and I suggest 
that you bookmark it. If you lose or forget the link you can have it sent back to you by email by entering  
the email address you used during the original purchase in the form on the download page.

BASIC OPERATION

Photosounder  can open many types  of  image and sound files.  Whereas  images  are  loaded largely 
untransformed, sounds first have to be processed and turned into a kind of image called spectrogram. 
That image represents features present in the sound loaded in a way that allows it to be turned back into  
sound in a relatively faithful way. A notable difference between images obtained in such a way and 
regular images in Photosounder is the former present a much higher precision in their intensity, and to 
represent this higher precision in a convenient fashion, their intensity is displayed in a very colourful way 
that helps you seize the slightest variations in the image in a glance.

Once either an image or sound is done loading (the latter which can take a few seconds depending on  



the length of the sound and the processing power of the machine it is running on), Photosounder starts 
synthesising the image into a new sound, which progress is depicted by the blue progress bar above the  
image. The light blue part of the bar is the part of the sound that remains to be synthesised, the medium 
blue area is the part of the sound currently being processed, and the dark blue part of the bar that  
displays a waveform is the sound you can already listen to by click the button Play. You can save the 
produced sound into a sound file by pressing the Save button. You can also save the image obtained by 
pressing the same Save button, and by choosing the image option in the drop-down menu. You can save 
and entire project (including every layer, setting and lossless data) by choosing to save to a Photosounder  
Archive file (.pha).

By default at the start, the Cursor tool is selected. It means that when you click somewhere on the image 
while playing the sound, the sound playback jumps where you clicked. You can also control the sound 
volume by turning the Volume knob in circles using the mouse. When the cursor is over the image, it will 
also indicate in the lower left corner of the window the time, frequency and pitch coordinates of where in 
the image your cursor is pointing. It can be particularly helpful if you're trying to determine the precise  
pitch of a note.

The window of Photosounder can be resized by clicking and holding the group of dots in the lower right 
corner of the window, and dragging the cursor to the position on the screen where the lower right corner 
of the window is desired to be.

CONTROLS OPERATION

In Photosounder, most settings are defined by knobs, which are controlled by the mouse. In order to  
change a value defined by a knob, simply click and hold anywhere on the circular area of the knob, and  
move the cursor in circles around the knob clockwise or counter-clockwise. For more precision in your 
movements, you can move the cursor further away from knob. For yet more precision, you can click and 
hold the right mouse button of your mouse, either simultaneously with the left button or independently,  
which allows you to spin the knob around 100 times slower.

PARAMETERS

A description of what each parameter means, from left to right and top to bottom :

Min. frequency Lowest frequency in the image, at the bottom of it. By default 27.5 Hz, also 
know as A0, one of the lowest notes we can hear.

Max. frequency Highest frequency in the image, at the top of it. By default 20 kHz, a frequency 
at the boundary of ultrasounds.

Frequency scale logarithmic base
Scaling of the frequency (vertical) axis going from linear (by convention here 1) 
to  logarithmic  (here  defined  as  2).  Any  setting  in  between  1  and  2  is  an 
interpolation, a form of compromise, between linear and logarithmic scaling. 
The logarithmic scale is used by default, as it's closer to the way we perceive 
frequency, but it's also the same frequency scaling as used in musical notation, 
which explains why notes and octaves on the right side of the image are evenly 
spaced.

Volume Volume of the playback sound. +0.0 dB means that the sound is normalised as 
to make the sound as loud as possible under any circumstance while avoiding 
clipping, which causes distortions. Therefore a volume above 0 dB should only 
be used to enhance the more quiet parts of a sound.

Time resolution Playback speed of the image. By default set to 100 pixels per second, which 
means that a picture 800 pixels long will make a sound 8 seconds long. Also the 
rate of images obtained from sound, which means that if you open a sound and 
set  the  time  resolution  to  0.5  pixels/second,  the  sound will  play  200  times 
slower than its normal rate, while if you set it to 2,000 pixels/second it will make 
the sound 20 times faster than usual, without changing the pitch of the sound.



Spray width Width of the area affected by the spray tools in pixels, in the scale of the screen.
Tool intensity Intensity of the spray tools or rectangle tool in percents.
Horizontal flip (FLIP) Reverses the image in time (horizontally).
Invert (INV.) Inverts the  colours/intensity of an image in the same way as a photographic 

negative.
Mask Invert (M.I.) Inverts the mask. Produces the difference between the original image and the 

current one.
Vision Mode  (V.M.) Switches the Vision Mode.
Gamma Gamma function, as it can be found in most image editing programs. Can be 

thought of as a sort of brightness function. The default (and neutral) value is 
defined here to be 1:1.

Layer intensity Changes the intensity of a layer with respect to other layers.

MOVE TOOL

This allows you to move a layer visually up or down, which transposes its pitch, or horizontally which 
changes when it occurs in time. Holding shift allows you to only move it on one axis. When you use the  
move tool to move a layer you can see in the lower left corner of the interface by how much in seconds 
and semitones the image is being shifted.

SPRAY TOOLS

In addition to the various effects you can achieve by adjusting the aforementioned parameters, you can  
also finely edit the features of an image-sound by using the Spray tools. The Spray tools, activated by  
clicking the second, third or fourth icons to the left of the image, can be used to highlight, tone down or 
erase features from image-sounds, or painting up new ones. It can be used to achieve many things, such  
as singling out a sound, suppressing a sound, reproducing traditional sound effects by imitating their  
effects in the time-frequency domain (this can be  learnt by loading a sound and a copy of it with the 
desired effect applied, and looking at the visual differences between the two), or even creating sounds 
from scratch.

Using these tools, a left click on the image will darken, brighten, paint up or smart erase (depending 
whether you've selected the black, white, flashlight or road roller spray tool) the area in the vicinity of the  
mouse cursor, area which will be defined by the Spray width parameter, with an intensity controlled by 
the Tool intensity setting and by how long the click is held. Inversely, if the right click is held, the same 
area will be progressively reverted to its original state. Therefore anything done with the Spray tools can  
be easily reverted. The reason for this reversibility is that a copy of the original image is kept in memory, 
and is used for reverting changes.

RECTANGLE TOOL

The rectangle tool works similarly as spray tools. Holding the left mouse button darkens the chosen area 
by a ratio defined by the Tool intensity knob, holding the right mouse button inversely brightens the area.

HARMONICS MODIFIER

If toggled, the harmonics modifier, represented by four vertically stacked dots, modifies the behavior of  
all spray tools by reproducing their action on the harmonics of the frequency that the mouse cursor  
points to. This allows for the simultaneous modification, suppression or creation of harmonic content.



MAGNET MODIFIER

If toggled, the magnet modifier snaps the mouse cursor to the nearest feature, determined by proximity 
and intensity. If the harmonics modifier is also toggled, the magnet modifier also takes into account 
harmonic content to determine which point to snap to. The point on the image to which the magnet  
modifier snaps is represented by a diagonal cross on the screen.

ZOOM

Photosounder allows you to zoom in on the image you're editing using the scroll wheel of your mouse. 
Scrolling up will zoom in in time, scrolling down will zoom out. You can zoom in frequency instead by 
holding the Shift key while scrolling, or zoom in both horizontally and vertically by holding the Control 
key. Once zoomed in, you can drag scroll the image by holding the middle mouse button or the End key 
and mouse the cursor around. Note that if you do not have a scroll wheel on your mouse you can use 
the Page Up and Page Down keys instead.

LIVE SYNTHESIS

When  live  synthesis  is  enabled  (in  the  Options  menu),  several  aspects  of  Photosounder  change  in 
behaviour.  The first  difference is  that  once the  live  synthesis  mode is  ready there is  no progressive 
processing of the whole sound, instead what is to be heard is synthesised right as you hear it. This means  
that you can hear changes to the image while you are making those changes, whatever they are. You 
can also change the playback speed instantly without having to release the Time Resolution knob to hear  
the change but rather while you turn it. This also enables you to synthesise sounds with a duration of 
several hours in a feasible way. Another difference is that by holding the mouse button while using the 
cursor you can make playback follow the mouse cursor and thus directly control the flow of time. The 
edges of the image are processed differently whether looping playback is enabled (either with the Loop 
Playback option or by holding the L key) or disabled. When it's  enabled the live synthesis algorithm 
interpolates the edges of the image as if they were connected as to smoothly transition across the edges.  
When it's disable the algorithm acts as if there was nothing before or after the edges, as it does in non-
live synthesis.
You can save synthesised sounds to a sound file as they are synthesised using the Save Live Synthesis 
Output to File... option in the Options menu. Only the samples actually synthesised are saved, pauses 
aren't considered so the saved output doesn't necessarily need to be edited further. Saving samples to the  
file can be paused by turning on the Suspend Output to File option.

III. Lossless mode

DESCRIPTION

By  default,  Photosounder  synthesises sounds  purely  from  image  data,  discarding  all  original  input 
sounds.  While  powerful  and offering much flexibility,  this  approach also  introduces  a  loss  in  sound 
quality. The lossless mode remedies to that by using the original sound as a basis for resynthesis, in the 
place of noise. It works by keeping an original sound and its untouched image, then comparing the 
differences  between  the  image  as  modified  by  the  user  and that  original  image,  and applying  the 
differences to the original  sound. Therefore, as long as a sound's image is  untouched, the resulting  
sound will be strictly similar to the original sound, hence the term lossless.



USAGE

In lossless mode, the last sound loaded and its associated original image are always kept in memory, and 
used in combination with the current image to produce the synthesised sound. This means that you can 
open a sound, export its image, edit this image in an image editor, then open this modified image with  
Photosounder in lossless mode, the resulting sound being the differences between the new image and 
the original image applied to the original sound.

The lossless mode is recommended for tasks such as erasing, filtering, isolating or enhancing sound 
features, noise reduction, subtraction and other operations between two different sounds and various 
time-frequency mastering operations.

LIMITATIONS

However, there are limitations inherent to the lossless mode which are important to keep in mind. The 
lossless mode works by comparing the matching pixels of the original sound's image and the current 
image and filtering the original sound in time-frequency according to those differences. This means that  
it is important not to displace anything in either time of frequency in order obtained the desired quality of 
sound. This is why several controls are locked in lossless mode, as using them would in the best cases  
produce a result of quality possibly worse than in lossy mode. It is also recommended to keep images to 
their original length.

IV. Layers

USAGE

Layers constitute a stack of individual images that combined together make up the final image that you  
see and hear. Using multiple layers allows you to do things you wouldn't be able to do otherwise.

By default when you open a sound, image or create a new image only one layer is present. You can add 
a new blank layer on top of that layer by selecting New Layer in the Layers menu, or duplicate that layer 
by selecting Duplicate Layer. You can see the list of layers at the bottom of the Layers menu. The currently  
selected layer is indicated by a check mark next to its name. You can delete the currently selected layer 
by clicking Delete Layer in the Layers menu. You can also move the currently selected layer up and down  
in the stack of layers by selecting Move Layer Up or Move Layer Down. You can switch between a view of 
all the layers combined or a view of only the currently selected layer by clicking View Current Layer Only. 
Likewise you can view only the current group of layers as separated by separators using the View Current  
Group Only. Unlike View Current Layer Only, View Current Group Only only lets you hear what you see.  
Both options can be combined to only view the current layer while only hearing the current group of 
layers.

Each layer has a blending mode associated with itself. The default mode is Addition, you can see in the 
Layers  menu  that  it  is  already  checked.  The  blending  mode  defines  how each  layer  is  affects  the 
combination of the layers below. Separators can be added between layers to create isolated groups of  
layers.  Layers  between  separators  are  combined  separately  from  other  groups  of  layers.  The 
combinations of each group of layers are then combined together according to the blending mode set for 
each separator. This can for example be used so that a layer with a blending mode set to Multiplication 
would only affect a precise group of layers and not every single layer below it.

Layers can also be merged into one using the Merge Down function in the Layers menu. The Merge 
Down function merges the currently selected layer with the layer right below it.  For this reason, the  



proper way to merge a group of several layers is to start by selecting the second layer from the bottom  
and to use Merge Down until all are merged together. Merging layers together in a different order could  
yield a result inconsistent with what was seen prior to the merging depending on the blending modes 
used. The combination of all layers can also be turned into a whole new layer at the top of the stack of 
layers using the Merge All to New Layer function.

V. Menus

FILE

New
Creates a new blank image. Its height is the default height for sounds (571 pixels by default) and 

its width matches the current width of the image area.

Open…
Opens a dialog to load a sound, image or saved project / script.

Resume Last Session
Loads the file ‘history.pha’ which was automatically generated during the previous session. Every 

action saves the corresponding command to ‘history.pha’ instantly, so you can always resume your work.

Save…
Opens a dialog so you can save your project as a sound (not in the demo) or a BMP image or a 

PHA (Photosounder Archive)  file,  which  depending on what you choose can either  be a history file,  
meaning it contains the sequence of commands used, or a status file in which case only the current state 
is saved. History files are generally preferable as they contain more useful information and can even 
allow you to change or undo some things using a text editor and are lightweight since they only contain  
such commands, but doesn’t include the dependencies which is the image or sound files loaded (those 
need to either still be found in their original location or in the same folder as the PHA file), whereas a 
status file contains raw data with no dependencies and is typically quite large.

Reload
Reloads the last file opened.

Quit
Quits instantly. Since you can always resume the last session (see above) you can quit at anytime 

and resume your last  session when launching the program again.  You can literally  Alt-F4 / -Q a⌘-Q a  
fraction of a second after your last action and when you launch Photosounder again and resume the 
session that last action is still there.

EDIT

Undo
Crude undo function which only saves the last version of the pixels of the current layer being 

edited. For more serious undoing open the file ‘history.pha’ found using Open Photosounder Files Folder 
in the Help menu with a text editor, edit out the last lines containing the actions you want to undo, save it  
then  choose  Resume  Last  Session  in  Photosounder’s  File  menu.  I  realise  that  this  method  isn’t  as 
immediately convenient as conventional multiple undo, however it’s also much more powerful since you 
can edit the actions done so far in any way you want.

Copy



Copies  the  current  image  (the  final  image,  not  the  current  layer)  to  the  clipboard.  Not 
implemented on Mac.

Erase Mask
Restores the original image.

Default Values
Resets all the knobs to their default values.

OPTIONS

Loop Playback
Loops the playback when toggled.

Pause After Current Loop
Pauses the playback when the end of the loop is reached. Very useful when saving live synthesis 

to file to make loops end neatly. Can also be used to make edits between each iteration of a loop being  
exported in this way, for instance playback the loop, have it be paused after 4 iterations, then turn on a 
layer then resume the playback, and the recorded transition can be seamless.

Live Synthesis
Turns on live synthesis, which has the characteristics outlined above in the paragraph explaining 

it.

Suspend Processing
Stops the sound from being rendered. This is useful when doing many edits and the sound is 

being rendered when you don’t want it to be.

Constant Time Resolution Analysis
By default Photosounder varies the time resolution when analysing sounds by giving less time 

resolution to the basses to increase their frequency resolution. This option gives every frequency the  
same  time  resolution,  which  is  mostly  useful  when  processing  dynamics,  like  doing  effects  to  the 
envelope of a sound.

Save Live Synthesis Output to File…
When you select it it asks you to save to a sound file, then every sample that you play from that  

point on will be saved to a file (and none of the pauses). The saving is completed when you select that  
option again to turn it off.

Suspend Output to File
Pauses the live synthesis output to the sound file. This allows you to make edits and listen to 

them, but very importantly when you resume the output the live synthesis goes back to the position in the  
noise tables where it stopped, so that the saved output can be seamless.

Unnormalised Output
The sounds generated are typically normalised for playback, that means the highest audio peak 

will be normalised to ±1.0 / 0 dB. This is a problem when processing stereo channels separately as one 
might come out as having more gain than the other, throwing off original the stereo balance. When 
Unnormalised Output is selected the peak is brought somewhere between ±0.1 and  ±1.0, so the two 
channels should have the same gain applied, or in some rare cases one might be 10 times quieter than 
the other, which can easily be fixed in an audio editor.

Load Left Channel Only
Load Right Channel Only

When one of those two options is selected then instead of mixing down a stereo sound to mono 
before analysing it only one of the channels is loaded.

Mix Channel Files to Stereo…



This asks you to select a left channel sound file, then a right channel sound file, then where to  
save the stereo mix of the two. With this you can edit the left channel first and save it, then do the right  
channel, and then combine the two into a single file.

Long Block Duration
The default for noise synthesis is to use as a basis for synthesis a sound that loops in about 2  

seconds. The looping is generally not audible, however in cases when it is or when it  is visible (like  
turning an image into a sound for the purpose of having that image visualised in a spectrum analyser) 
this option increases the loop duration to over 120 seconds.

Linear Knob Control
When turned on knobs are controlled by a vertical cursor movement. When turned off a circular  

movement is used instead.

HISTORY

The  History  menu  is  a  hidden  menu,  it  can  only  be  seen  by  editing  ‘config.txt’  and  setting 
history_menu_on to 1. This is only useful for people who want to script and need to control which units 
are used when recording actions.

Time in pixels
Time in percents
Time in seconds

Positions in time are typically recorded in seconds, this is convenient when drawing over a sound, 
you can then edit the history to have different analysis time resolution which would change the position 
of the drawing if it was recorded in pixels, recording in seconds keeps this unchanged. However in some 
cases a scripter might want to use different units.

Frequency positions in pixels
Frequency positions in percents
Frequency positions in Hertz
Frequency positions in notes

Absolute positions are by default recorded in Hertz. Name of notes with cents can also be used, 
which is useful when drawing music.

Frequency dimensions in pixels
Frequency dimensions in percents
Frequency dimensions in semitones

This is the unit in which things like vertical shifts are recorded, like when moving a layer up or 
down. Semitones are the default.

Relative selection index
By default selecting a different layer records that change as an absolute count from the first layer.  

This can be inconvenient when creating a script that might be loaded on a project with any number of 
layers.  This  options  records  instead  the  new  selection  as  an  offset,  positive  or  negative,  from the 
previously selected layer.

VIEW

Force Fast Image Display
Force Smooth Image Display

Photosounder  chooses  whether  to  use  a smoother  bilinear  filtering  for  displaying  images  at 
higher zoom levels or the faster nearest neighbour algorithm when zoomed out. These options allow you 
to force the choice.

4/4 Rhythm Overlay



Shows a 4/4 overlay over the image as if it is a loop. Useful for editing loops.

Semitone Overlay
Shows horizontal dashed lines when zoomed in vertically. The lines with the longer dashes match 

the white notes of the keyboard. Useful when trying to draw notes.

TOOLS

Cursor
The default tool, it allows you to set the position of playback on the image. When live synthesis is 

enabled you can by holding down the mouse button and dragging the cursor around the image countrol 
directly the playback.

Move Tool
Rectangle Tool
Dark Spray
White Paint Spray
Brighten Spray
Smart Erase
Harmonics Modifier
Magnet Modifier

All these tools are explained in the Getting Started chapter.

OPERATIONS

Invert
Inverts  the  current  layer.  Useful  when  an  image  has  a  light  background  (this  is  typically  

undesirable, only images with dark backgrounds make interesting sounds).

Mask Invert
If you load a sound and darken some of its elements for instance using a spray tool, then you can 

get the opposite result using Mask Invert. Let’s say you remove an instrument from a sound, using Mask 
Invert will give you that instrument and nothing else.

Horizontal Flip
Vertical Flip
Rotate Clockwise (90°)
Rotate 180°
Rotate Counter-Clockwise (270°)

Self explanatory. It should be noted however that rotations by 90° and 270° change the image a 
bit,  since  images  used  in  Photosounder  can  easily  be  tens  of  thousands  of  pixels  long  but  should 
preferably not exceed about a  thousand pixels  of  height  then those two rotations keep the original 
unrotated dimensions of the image.

Horizontal Average
Averages every row of pixels. This is very useful when doing anything with curves, for instance  

you can draw a curve, fill  it  to the left (see below), then horizontal average it  and by using it  as a 
multiplication layer for instance you can use it as an equaliser, or using it as a subtraction layer you can 
use it to remove a constant noise.

Vertical Average
Same as above except vertically. Useful for editing dynamics or creating evelopes.

Horizontal Curves
Vertical Curves

These do the same thing as the averaging operations, however instead of averaging all the rows 



or columns of pixels it creates a sort of filled curve that you can visualise and edit, for instance you can 
erase a peak from a curve using a spray tool, then average it to use it as an effect. You can go back and  
forth between curves and averages for all kinds of effects, for instance you can darken slightly the peaks 
of a sound’s vertical curve to achieve a kind of dynamic compression.

Fill from Maxima to Left
Fill from Maxima to Bottom

These allow you to create your own curves from scratch. Simple draw the curve you want on a 
blank layer using the white spray tool, then use a Fill from Maxima operation which fills up the curve, 
then after shifting using the Move Tool to cut out the parts that must be cut out you can use the matching  
Average operation. Useful when trying to create an envelope or equalisation curve.

Normalise to 1.0
As a result of operations the range of values of layers can swing wildly. This operation makes the 

brightest pixel have a brightness of 1.0.

Set Pixel Sum to 1.0
Sets the sum of pixels to 1.0. This is useful when creating a layer for convolution as you might 

want to keep the brightness of the result constant by having the convolution layer have a pixel sum of  
1.0. For instance you can blur an image simply by convolving it with a layer that only contains a blurry 
dot. But if you don’t set the pixel sum to 1.0 it might make the blurred image vastly brighter than the 
original, which might be a problem.

Horizontal Normalisation
Vertical Normalisation

Normalisation makes every row or column have the same sum of pixels. This makes Horizontal 
Normalisation give you a flat spectrum and Vertical Normalisation give you a flat envelope. A usage  
example would be transforming the dynamics of a sound, you would duplicate the original image’s layer,  
in the lower of the two you’d apply Vertical Normalisation while in the upper layer you would apply 
Vertical Average, and you could set the upper layer to Multiplication, which would give you the original 
image  and  its  sound  back,  however  now  you’d  be  able  to  edit  the  dynamics  in  the  upper  layer  
independently from the rest.

1 / x
Square
Square Root

These operations apply those mathematical functions to every pixel of a layer.

Fill with White Noise
Fill with Pink Noise
Fill with Brown Noise

Fill the current layer with a specific type of noise.

Group to Nearest Semitone
All rows of pixels are moved to the nearest semitone. Can be somewhat useful for turning some 

kinds of images or drawings into musical notes.

LAYERS

New Layer
Adds a new blank layer above the current one.

Duplicate Layer
Adds a copy of the current layer.

Add Separator
Adds a separator layer, which is a layer with no image data, but that can be used to make 

groups. A separator layer’s blending mode defines how the layers above the separator are blended with  



the layers below it.

Merge Down
Merges the current layer with the layer below itself according to the current layer’s blending 

mode.

Delete Layer
Removes the current layer entirely.

Merge All to New Layer
Creates a new layer at the top of the stack of layers, and that layer is the same as the overall 

result of all the layers.

Move Layer Up
Move Layer Down

Moves the layer in the stack of layers.

View Current Layer Only
Shows you only the current layer, but you can still hear every layer.

View Current Group Only
Shows you only the result from the current group of layers, a group of layers being defined by 

separator layers.

Set Central Convolution Point
Convolution / Propagation layers need a point of origin. Convolution works by replacing each 

pixel from an image with the whole of the convolution layer, so we must have a point on the convolution 
layer that represents the centre of that convolution. For instance if we want to blur an image by creating  
a convolution layer that only contains a single blurry dot, then the central convolution point must be at  
the centre of that blurry dot, otherwise the result of the convolution will show a shift. By default the first 
click with a spray tool in a layer sets the central convolution point, so most of the time you don’t need to 
set it yourself.

Turn Off Layer
Turns off a layer both visually and in the sound, kind of like deleting the layer except you can  

always turn it back on.

-

The following are blending modes. The define how the current layer is combined with the result of the  
stack of layers below.

Addition
Adds the layer, it is the default mode.

Multiplication
Multiplies the layer, as you would for instance if trying to apply an equalisation layer to the sound 

below.

Division
Division (Reverse Order)

Divides the layer by the stack result or vice verse with Reverse Order. Useful for trying to go the 
other way of multiplication, for instance dividing by a smooth frequency profile to flatten the spectrum.

Subtraction
Subtraction (Reverse Order)

Subtracts, useful for trying to subtract a noise profile to a noise-containing sound for instance.

Difference
Gives you a subtraction going both ways. I’ve never had a use for it but it doesn’t hurt to have it.



Minimum
Maximum

Compares the pixels of the layer and the stack result and picks either the darkest or the brightest. 
If the top layer is a flat image you can adjust its brightest to define a limit to the values of the layer below 
for example.

-

The following blending modes are very different and hardly ever encountered in image editing software, 
but very powerful. The blending modes above operate on independent pixels, for instance a pixel at a 
precise position on a layer is adding to the pixel at the very same position on another layer, and none of  
the  neighbouring pixels  can  have  any influence,  that’s  typically  how blending  works.  The  following 
however are very different, they’re convolution modes, that means that for full  2D convolution (here 
called simply “Convolution”) each pixel from the layer below is replaced with a full copy of the layer 
above, shifted according to the position of that pixel and multiply according to its brightness.

So a bright pixel in the top right corner of the image will create a bright copy of the convolution layer in  
the top right corner of the resulting image, while a darker pixel in the centre of the image will create a 
darker  copy  of  the  convolution  layer.  If  that’s  confusing  the  best  way  to  get  a  more  intuitive 
understanding of it is to try it. I recommend using the white spray tool at its thinnest, creating an empty  
lower layer, then creating an upper layer and drawing on it a shape like a tiny star, set it to Convolution  
then go back to the lower layer and draw a path. You’ll see the shape work as if it was a brush. Instead 
of a star shape you can try a few separate dots, which will create copies according to the position and  
brightness of those dots.

If you’re looking for a quick way to create rich and strange sounds it’s highly recommended that you 
experiment with the following convolution modes. Simply applying one of the Propagation modes to a 
sound’s image with the flipped or rotated version of itself can instantly create fascinating soundscapes or 
strange harmonies.

Vertical Propagation
Vertical “Propagation” is a form of convolution that only happens vertically. This means that every 

pixel of the lower layer is replaced with the whole matching column of pixels from the upper layer, rather  
than the whole image. It’s very useful and interesting for more musical effects. If your vertical convolution 
layer is  a harmonic series of horizontal lines going across the image, then the result will  be to add 
harmonics to your lower layer, so that for instance you might have a lower layer that shows notes as 
single lines and a vertical propagation layer that only has harmonics. The result will be the same notes 
but with added harmonics, and you can edit the two separately. You can also use this mode for pitch-
shifting according to a curve, or even by notes. For example in this video I flattened a melody by keeping 
the original image in the lower layer and transformed a copy into only having lines that represent the 
notes of the melody, then flipped those lines upside down so that the melody would be upside down. 
With Vertical Propagation this had the effect of shifting every note to the same position, thus flatting the 
melody to the same note, except when two notes were playing at the same time in which case the 
vertical convolution resulted in 3 simulatenous notes, with symmetry around the middle one. One could  
use a different melody to create something different, or even do a Vertical Propagation with a single 
straight line then adding extra parallel line to create chords. The possibilities are many. I often use a 
single straight horizontal line made by a blurry white done average horizontally as a vertical propagation 
layer in order to blur a sound only vertically, I do this to fuse the sound’s harmonics together, which I may 
use for vocoding or to separate formants and pitch-shift overtones without shift formants, which may be 
considered a better way to do pitch shifting.

Horizontal Propagation
Horizontal Propagation (Looped)

Horizontal  propagation follows the same principle except  of  course  horizontally.  This  can be 
useful for creating a reverb. In that case you would create a layer with a thin vertical line as a basis, a  
single straight line would give you an unchanged image, then give it a trail (using the Operations starting 
from a handrawn curve depicting the desired envelope over time would do well) would create an effect  
similar to a reverberation. Since it operates on a per-row basis, this means that you could modify your 
layer so that for instance you have more trailing reverberation at the bottom in the basses than at the  

https://www.youtube.com/watch?v=undU5wWnUdU


top, or any creative effect you can imagine. The Looped version continues the convolution from one edge 
in time of the image to the other, so that if you use it for a reverb in a loop then that reverb loops  
seemlessly instead of stopping at the end of the loop. Horizontal Propagation, or horizontal convolution, 
is very much the equivalent of audio convolution, spectrally it does about the same thing, which is a good 
thing to remember if you enjoy using audio convolution for creative effects as you can do the same with 
this horizontal convolution mode.

Convolution
Convolution (Looped)

This is the convolution described earlier, the one in which each pixel of a layer is replaced with 
the entirety of the other. This is a great way to generate interesting images simply by drawing with the 
white spray tool. You can this instantly by drawing a horizontal wavy line on the lower layer, then a 
vertical wavy line on the upper layer then setting the upper layer to Convolution. But it can also have 
very practical uses. A convolution by a single sharp dot doesn’t do much, but convolution by two sharp  
dots creates a double image. You can have a note on the lower layer, maybe from a sample, then on the 
convolution layer by placing sharp dots apart from each other by a few semitones and the right intervals  
in time create a melody, by creating copies of that original image at the positions specified by the dots. 
Likewise you could repeat a drum by placing dots at regular intervals throught a loop, then editing the  
drum layer would propagate the changes to all its copies instantly, and you could remove dots as you 
like. You could have a sharp dot and then to the right an octave below or a fifth above have a trailing dot  
to create a transposed reverb effect. Once again the possibilities are many.

You might notice that Convolution gets quickly very slow. That’s because we’re making a copy of an 
entire layer for every pixel in the other layer, this takes a lot of operations, it’s bound to be pretty heavy.  
Just keep in mind that in order to make things quicker Photosounder only makes copies for the non-zero 
pixels in the convolution layer, so therefore the less non-zero layers the quicker it will be computed, and 
if your convolution layer has no zero-value pixels then you’ll never see the end of it (well, it might take a  
couple of  minutes  depending on what  you’re working with),  that’s  why typically  a convolution layer 
should be something you draw.

HELP

Open Manual…
Opens the PDF manual.

Check for Updates Online…
Takes you to the download page.

Open Photosounder Files Folder
Opens the folder in Explorer / Finder where files like ‘history.pha’ and ‘config.txt’ are stored. This 

is where you would go to edit the configuration file or edit the history file to change or undo some things.

VI. History and scripting

HISTORY

While using Photosounder, all actions are recorded in real time to an history file (history.pha, located in 
the program's folder) in an easy to read and to edit format. This enables you to resume your work from 
last session (using Resume Last Session in the File menu) without losing a thing and with an identical  
result, even if the program didn't quit correctly or if the computer suddenly shut down. This also enables  
you to save a session's history to a typically small file (usually in the tens or hundreds of kilobytes).



History files are easy to read text files that can be edited with any text editor. This means you can edit the  
recorded actions to change the recorded history. You can undo a number of actions by deleting them, 
even if they're in the middle or the beginning of the file, change parameters or even add missing actions.

SCRIPTING

Recorded history files typically record everything from the creation of a new image from scratch or from 
the opening of another document. By editing a recorded history file into removing the commands at its  
beginning which either create a new image or load a document you can make a file that when loaded 
will apply the subsequent actions to what is already in memory. You can for example open a sound, apply 
a series of actions to it to obtain a desired result, edit the history to remove the part that opens the 
sound, save this modified history into what can now be thought of as a script that will reproduce the  
recorded actions. Therefore you can load any other sound, then open that script so that the same actions  
will be applied to the sound currently loaded.

You can also type new commands by hand. For a reference on the scripting language please refer to the 
Photosounder Archive Specification.

VII. Keyboard shortcuts

O Equivalent of the Open button

S Equivalent of the Save button

Esc Equivalent of the Quit button

Space Equivalent of the Play/Pause button

C Copy function. Copies the current image to the clipboard, allowing it 
to be pasted in other image editing programs.

R Reload function. Reloads the sound or image from the file. Most 
practical when modifying in parallel the input file with another image 
or sound editing program to quickly reload a file freshly updated 
from another program.

U Undo function. Cancels the last action on the image. Redoes it if 
pressed again.

E Erase changes function. Cancels everything that has been done 
with the Spray tools or Rectangle tool from the beginning.

D Default values function. Resets the default values for the knobs 
Min./Max. Frequency, Time resolution, Gamma, Logarithmic base, 
Spray width and intensity.

N New layer. Adds a new layer on top of the selected one.

J Joins the selected layer with the layer right under it.

Del Deletes the selected layer.

V View current layer only switch.

Shift+V View and edit current group of layers only.

T Turn off current layer. If a separator is selected then the entire group 
that it represents (the layers above itself until the next separator) is 
disabled.

http://photosounder.com/documentation.php


L Loop function. Loops back to the beginning of the sound if the key is 
held when the end of the sound is reached.

B Backwards playback function. Plays the sound backwards when 
held.

L + B Ping-pong playback function. Plays the sound back and forth when 
the two are simultaneously held. If B is pressed before L then it will 
start by playing the sound backwards, until it reaches the beginning 
of the sound and starts playing forwards again.

Shift + Space Pauses playback after the current loop ends. Useful for when 
looping playback, live synthesis, saving live synthesis output to a file 
and suspension of that output are used together and a pause at the 
end of the loop is needed.

H High precision cursor function. When held the mouse cursor goes 
at a fraction of its normal speed as to allow high precision editing.

F Force function. When held, this button allows you to force the 
modification of locked (grayed out) controls when in lossless 

mode.

K Kill processing. Suspends synthesis of sound until pressed again, 
until the Play button is pressed or until the project is exported to a 
sound.

Down Arrow Full rewind function. Jumps back to the very beginning of the 
sound.

Up Arrow Stop function. Jumps to the very end of the sound.

Left Arrow Jump back function. Rewinds the sound by 1 second.

Right Arrow Jump forward function. Fast forwards the sound by 1 second.

Scroll Up / Page Up Zoom in horizontally.

Scroll Dn / Page Dn Zoom out horizontally.

Shift + Scroll Zoom in/out vertically.

Ctrl + Scroll Zoom in/out both ways.

Middle Click / End Drag scroll the image.

VIII. Advanced options

STEREO OPERATIONS

Photosounder operates entirely in mono. However, there are four options in the Options menu that can  
be used to treat each channel of a stereo sound separately and join the output into a stereo sound file.

The  Load Left Channel Only and  Load Right Channel Only options can be used so that when a 
stereo sound is loaded one of the two channels is loaded instead of an even mono mix of the two. You 
can therefore treat each channel separately and save the results for each into a separate sound file.  
However, before you save, you should make sure to toggle the Unnormalised Output option. Usually 
sounds are normalised so that their  highest  peak is  set  to 0 dB.  This  means that  in the process  of 
normalisation, one of the two channels might be amplify more than the other, therefore offsetting the 
pan in either direction. This does not occur when Unnormalised Output is enabled. However note that if  
one channel appears to be 100 times (+40 dB) louder than the other, just amplify the other channel  
accordingly by +40 dB. Unnormalised Output amplifies the output by multiples of 100 (40 dB) so that the 
peak amplitude of the output is always between -40 dB and 0 dB.



Once you've saved both the left and right channel to individual files, you can join them together into one 
stereo file by using Mix Channel Files to Stereo... in the Options menu. A first open dialog will appear 
with which you should select the left channel file. A second open dialog will appear so that you can select  
the right channel file. Then a save dialog will appear so that you can save the mix of the two files to a 
new sound file.

MISCELLANEOUS OPTIONS

In the Options menu, Loop Playback can be toggled so that the sound playback always loops.
Force Fast Image Display can be enabled so that the fastest method for displaying the image on the 
screen is  used.  Likewise,  Force Smooth Image Display can be used for  the  slower  but  smoother 
method  for  displaying  the  image  to  be  used  at  all  times.  When  neither  of  the  two  are  enabled  
Photosounder uses either of the two methods depending on the context. Long Block Duration can be 
enabled so that synthesis uses a noise that loops every 60 seconds instead of one that loops every 2  
seconds. This is recommended in cases the 2 second repetition is undesirable. Linear Knob Control will 
change  the  way  knobs  are  control  from  a  circular  control  to  a  vertical  linear  control.  Suspend 
Processing will  suspend  the  resynthesis  of  sound  after  every  time  it  is  modified.  Constant  Time 
Resolution Analysis is a useful option to analyse sounds with a constant time resolution. It is equivalent 
to editing the configuration file's  min_bpo value to 0,  except that  it  doesn't  require a restart  of  the 
program and it doesn't modify the configuration file.

CONFIGURATION

Some parameters  used by Photosounder can be permanently  altered by  modified the file  'config.txt'  
created by Photosounder in its folder. The numerical values can be changed by editing this file in a text  
editor, the changes taking effect the next time Photosounder is started. Note that the configuration file is  
regenerated every time Photosounder starts to reflect how the contents of the file were interpreted.

audio_buffer_size Size  of  the  audio  buffer  used  for  audio  playback  in  samples.  If  you  
experience stutter you should try to increase it to such values as 4096, 
8192 or even 16384. Otherwise you can try lowering it to other powers of 
two such  as  512 or  1024 in  order  to  obtain  less  delay  in  the  sound 
playback.

audio_sample_rate Internal  sampling  rate  used  playback,  internal  processing  and  audio 
output.

waveform_display_height Height of the waveform display in pixels. An odd height is preferred.
cursor_slow_rate Fraction of the normal mouse cursor speed when the H key is held down.
spray_harmonics Number of harmonics (base frequency included) the harmonic modifier 

creates.
initial_pha_size_limit Maximum allowed size in MB of the history file after loading a file in  

Photosounder. When below the limit, all the necessary data is written to 
the history file. When over the limit, all the data is replaced by a mere 
Open command with the path to the opened file, meaning the history file 
is dependent on that original file.

save_to_pcm_24 Saves WAV and AIFF files to 24-bit integers instead of 32-bit IEEE float.
live_cursor_fps Indicates how many times per second the position of the mouse cursor  

should be updated when the cursor drives the live synthesis. The lower 
value the smoother and laggier the movement.

min_frequency Minimum frequency used for analysis and by default.
max_frequency Maximum frequency used for analysis and by default.
pixels_per_second Time resolution in pixels/second used for analysis and by default.
bands_per_octave Vertical resolution of the image after analysis defined by pixels/octave.



min_bpo Minimum effective pitch resolution in pixels/octave used in the analysis.
max_time_res_for_min_bpo Time resolution in pixels/second at  which  the  time resolution will  stop 

increasing while the pitch resolution increases from the minimum pitch 
resolution defined by min_bpo.

history_menu_on If  set  to  1 it  activates  the History  menu which gives  access  to several 
history writing options. 

The last four parameters define the varying effective time and pitch resolutions in the following manner.  
The pitch resolution in the lowest frequencies is defined by  min_bpo. As we go up in pitch, the time 
resolution increases,  while  the pitch  resolution remains  constant,  until  we reach the time resolution 
defined by max_time_res_for_min_bpo. Then the time resolution remains at that value while the pitch 
resolution increases. When the pitch resolution reaches  bands_per_octave, the time resolution starts 
increasing again until it reaches pixels_per_second. The first two parameters are independent from the 
two  others,  which  means  that  you  can  safely  increase  pixels_per_second and  bands_per_octave 
without the appearance of the result being affected for the lower frequencies. Likewise you can change 
the values of min_bpo and max_time_res_for_min_bpo to change the effective resolutions in the lower 
frequencies without having any impact on the results in the higher frequencies.

There are other parameters in the configuration that are undocumented here, it is because they are 
modified by the program and do not need to be changed by hand.


